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Preface
Computer : Computers, a series of eight books, is a carefully arranged Computer series, 

that perfectly complies with the NCERT syllabus criteria and the National 
Curriculum Framework's vision. In auordance with NEP 2020’s guidelines, 
the series adopts an interactive approach to make Learning about 
Computer enjoyable for students. This book includes enough questions in 
accordance with the NEP criteria. The fundamental principles of NEP which 
are recognising, identifying and fostering the unique capabilities of each 
student, respect for diversity, and respect for the local context in all topics, 
are always kept in mind while creating the book.

  The topics are introduced in a way that children experience and learn 
through exploration.

  Child-friendly language and contextual images have been incorporated 
throughout the series to make the material more understandable for young 
readers. This allows them to connect what they read and relate it to the 
views, ideas and experiences they encounter every day. 

Salient Features of the series:

Learning Outcomes : It shows the right path of learning to the teachers as well as students. It 
establishes the direction of learning for effi cient and superior learning 
results.

Warm Up : Children can connect their prior knowledge to the chapter's topic through 
simple yet engaging activities.

Teacher’s note  : An outline of guidelines for teachers to follow in the classroom in order to 
make lessons interactive and discussion-based.

Let me answer : Questions related to the topic which are  essential for checking pupil 
understanding and keeping them engaged with the task at hand.

Do You know : An interesting piece of information related to the topic.

Remember It  : Additional information about the topic to encourage children to wonder 
about various surroundings.

Kids’ IQ  : These questions have been included to reinforce learners to think, analyse 
and apply.

Up skill your 

Intelligence :  Ample exercises with a range of questions to support learning.

Critical Thinking : Questions which allow the learners to think clearly and rationally. Further, 
permit the learners to understand the logical connections between ideas in 
order to analyse facts and come to a conclusion. 

Team Work  : It enables the students to collaborate with others.

The content is structured and well-graded. Sincere efforts have been taken to prevent any 
inconsistencies and make this series a perfect complement to the students' education. Any worthwhile 
recommendations for how to improve the series are always welcome and greatly appreciated.

             Author
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ADVANCED FEATURES OF EXCEL1

Teacher’s 
Note:

Guide students with the help of a chart to easily understand the data and compare values.

At the end of this chapter, students will be able to:

  Make charts in Excel.

  Recognise the components of a chart.

  Format charts and sort data in a worksheet.

Learning Outcomes

Warm-up

Observe the following chart carefully. What does it represent?
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In order to effi  ciently handle a big amount of information in spreadsheets, Excel off ers 
several extremely helpful functions including charts, sorting, and fi ltering data.

Humans are visual learners, therefore when given reference visual points, their under-
standing is enhanced. One effi  cient way to represent data in a pictorial form is through 
charts. We can easily understand and compare data values with the help of charts.

Charts depend on the data of a worksheet. When the information in the spreadsheet changes, 
the chart is immediately updated. 

 MAKING A CHART

As stated above, in order to insert a chart in a worksheet, we need to add some data to it.

Follow the given steps to make a chart in Excel:

Steps:

1. Select the data from which you want to make a chart.

2. Click on the Insert tab.

Hey Friends! Let’s learn how to 
make charts using the data from 
the worksheet.

Figure 1.1: Creating chart

Let Me Answer
Have you ever made a chart in 
your Mathematics class?
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3. In the Charts group, click on see all charts button to open the Insert Chart window.

4. Click on the All Charts tab and from the list of charts shown in the le�  pane select 
column.  

5. Click on the ‘ok’ button to insert the chart in the worksheet.

 ELEMENTS OF A CHART

Various elements of a chart are:

1. Chart Area: All the area and other objects of a chart are included in the chart area. 

2. Category Axis: � e horizontal area of a chart is called the X-axis or category axis.  

3. Value Axis: It is the vertical axis which is used to plot the values and is called the Y-axis. 

4. Data Series: Data series consists of the bars, slices, lines or additional elements that 
show the data values.

5. Category Name: � e labels visible on the X and Y axes are the category names.

6. Plot Area: A window within the chart area is the Plot Area. 

7. Legend: Colours, patterns, or symbols assigned to the data 
series are depicted by legends.

 FORMATTING A CHART

� e look of the chart is enhanced by formatting. Chart elements, chart styles, and Chart 
Filters can also be formatted. We can also change the numbers on the value axis, and hide 
or show gridlines.

Figure 1.2: Insert Chart Figure 1.3: All Charts

Let Me Answer
Defi ne x-axis and y-axis.
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Changing the Title of a Chart

Follow the given steps to edit the Chart title.

Steps:

1. Click on the chart title.

2. Right-click on the Chart Title placeholder, the pop-up menu will appear.

3. From the pop-up menu, select the Edit text option.

4. Add the new Chart Title and press the ESC key.

Editing Chart Elements

Titles, labels, gridlines and data labels can be edited. 

Follow the given steps to edit the elements.

Steps:

1. Click on the Chart.

2. � e following pane will be displayed.

 EDITING CATEGORIES IN A CHART

Follow the given steps to edit categories of the chart.

Steps:

1. Click on the chart.

2. Click on the fi lter button. 

3. Select the Categories option and unselect 1 from the Panel.

4. Click the Apply button and see the changes.

Do You Know?
Select the data in the worksheet and press 
the F11 key to create a chart instantly.

Figure 1.4: Chart Elements

Click to edit titles, labels, 
gridlines, and data labels.

Click to edit chart styles 
and color schemes.

Filter the values.
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 FORMATTING LEGENDS

Follow the given steps to edit the legends in the chart. 

Steps:

1. Right-click on the legend.

2. From the pop-up menu, select the format legend option to open the Format Legend 
Panel.

3. Click on the Fill and Line option.

4. Select the solid fi ll option.

5. From the colour drop-down list, select the colour of your choice.

Figure 1.5: Chart Filters

Figure 1.7: Legend Option

Figure 1.6: Editing Chart Categories

Figure 1.8: Format Legend
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 SORTING DATA

Sorting is a feature in MS Excel that helps you organise data. You can sort a text column in 
alphabetical order (A-Z or Z-A). We can sort a numerical column from the largest to the 
smallest or the smallest to the largest. We can also sort a date and time column from the 
oldest to the newest or the newest to the oldest.

Follow the given steps to sort the given data.

Steps:

1. Select the range of cells containing the data to be sorted. 

2. On the Data tab, in the Sort and Filter group, click on the sort option to open the Sort 
dialogue box.

3. From the Sort by drop-down list, choose the column which you want to sort.

4. Select the values 
option from the 
Sort On drop-
down list. 

5. From the Order 
drop-down list, 
choose the order of 
sorting- largest to 
smallest option.

6. In the Sort dialogue 
box, click on the 
Add Level button 
to add a new level 
below the fi rst level.

7. Specify the 
column name as 
mentioned in the 
sheet by dropdown 
list and order of 
sorting as A to Z 
in the Order drop-
down list in the 
new level.

Figure 1.10: Sort

Figure 1.9: Sorting Data
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Filtering Data

Filter temporarily hides some of the data in a table, so you can focus on the data you want 
to see.

Follow the given steps to fi lter data. 

Steps:

1. Select the data you need to fi lter. 

2. On the Data tab, click on the fi lter option in 
the Sort & Filter group. 

3. � e fi lter arrows appear next to each column’s heading. 

4. Click on the arrow next to the column to specify a condition.

5. A drop-down list appears which provides many options for fi ltering data. 

6. Select the checkboxes of the values based on which you would like to fi lter the data and 
clear all other checkboxes. 

Figure 1.11: Sorting Data with Multiple Columns

Figure 1.12: Filter Data

Ensure that the item of each data type in a 
column is identical before fi ltering the data.

REMEMBER IT!

Ensure that the item of each data type in a 
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7. Click Ok. 

8. Observe the list which is fi ltered according to the chosen criteria.

Kids’ IQ
Sangam has created a chart that shows the grades he received in several exams. He 
immediately realised that he needed to modify the colours and symbols used to represent 
the data series a� er creating the chart. Which part of the chart should he use to make the 
same changes?

Let’s Recall
•	 � e chart is immediately updated when the information in the spreadsheet changes.

•	 � e labels visible on the X and Y axes are the category names.

•	 � e horizontal area of a chart is called the X-axis or category axis.  

•	 Data series consists of the bars, slices, lines or additional elements that show the 
data values.

•	 � e look of the chart is enhanced by formatting.

•	 Sorting is a feature in MS Excel that helps you organise data in a particular order. 

•	 Filter temporarily hides some of the data in a table, so you can focus on the data 
you want to see.

Figure 1.13: Filtered Data
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Upskill Your Intelligence

A. Fill in the blanks.

 1. Charts depend on the data of a .....................

 2. � e area and other objects of a chart are included in the .................... area.

 3. Category axis is also called as .....................

 4. A window within the chart area is the .................... area. 

 5. .................... just temporarily hides the data. 

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. � e X-axis is a vertical axis. 

 2. � e look of the chart is enhanced by formatting. 

 3. Titles, labels and gridlines cannot be edited. 

 4. Filter helps you organise data in a particular order. 

 5. Formatting improves the appearance of a chart. 

C.  Answer the following questions.

 1. Explain any three elements of a chart.

..............................................................................................................................................

..............................................................................................................................................

 2. What do you mean by fi ltering?

..............................................................................................................................................

..............................................................................................................................................

 3. Write down the steps to sort data.

..............................................................................................................................................

..............................................................................................................................................
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 4. State the diff erence between sorting and fi ltering.

..............................................................................................................................................

..............................................................................................................................................

 5. Write the steps to change the title of a chart.

..............................................................................................................................................

..............................................................................................................................................

Critical Thinking

 Ramesh is the head of the accounts department in the organisation. He has made 

an Excel sheet which displays the name, designation, salary and bonus of each 

employee. However, he is asked to show the sheet to one of his colleagues but is not 

allowed to disclose the bonus given to each employee. Suggest to Ramesh how he 

can hide the specifi c data.

Team Work

 Work in pairs. Imagine your school has organised an inter-class race. In sheet 1, 

add the names and timings of the players in Team A. Further, add the names and 

timings of the players in Team B in sheet 2.
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MORE ON  PYTHON2

Teacher’s 
Note:

Assist students in doing the above exercise and give some more statements to them.

At the end of this chapter, students will be able to:

  Recognise Python keywords.

  Comprehend the fundamental rules of a language.

  Understand Syntax.

  Identify diff erent operators of Python.

Learning Outcomes

Warm-up

What will be the output if the given statements are typed in interactive Python mode?

1. >>>’Python is Fun’ 

2. >>>30 + 30

3. >>>’Shubham\Shubhi’

4. >>> 100% 30
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� ere are several laws that apply to every human language. � ese principles are language-
specifi c i.e., we adhere to the linguistic rules of the language in which we are communicating. 
Similar to this, if you want to instruct a machine using a 
programming language, you must adhere to the syntax, 
or set of rules of that language.

 SYNTAX

� e collection of guidelines that must be followed while writing programming statements is 
known as the syntax. � e interpreter will highlight a statement mistake if the proper syntax 
is not used.

For example, your science teacher fi nds 
out that the labelling of the diagram done 
by you is not correct, then she will mark 
the labelling as incorrect.

A syntax error might cause the programme to stop working by using improper punctuation, 
the wrong keywords, or undefi ned phrases.

Hello Friends! We covered the fundamentals 
of the Python programming language in the 
previous class. More information about the 
rules that govern the Python programming 
language will be covered in this chapter.

Figure 2.1: Syntex Error

Python is one of the 9 languages that 
infl uenced the design of JavaScript.

REMEMBER IT!

specifi c i.e., we adhere to the linguistic rules of the language in which we are communicating. 

Python is one of the 9 languages that 

Do You Know?
Many big names use Python for their products/services. 
Some of these are NASA, Google, IBM, Nokia,etc.


















































































































































































